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Read the Operating and Assembly Instructions prior to assembly,
starting installation and handling!
Keep for future reference!
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1 General

1.1 Information about the operating and assembly instructions

These operating and assembly instructions provide important instructions for working with the device.
They must be carefully read prior to starting all tasks, and the instructions contained herein must be
followed.

In addition, applicable local regulations for the prevention of industrial accidents and general safety
regulations must be complied with.

For other non SIL certified electronic function modules please refer to the separate Operating and
Assembly Instructions.

1.2 Scope of supply

The scope of supply of the electronic function module position switch UO-EM-ERC includes the Oper-
ating and Installation Instructions and the programming software ERCPro (on CD) and the program-
ming cable.

The Operating and Installation Instructions for further electronic function modules is also included on
the supplied CD.

1.3 Explanation of symbols

Warnings are indicated by symbols in these operating and assembly instructions. The warnings are
introduced by signal words that express the scope of the hazard.

The warnings must be strictly heeded; you must act prudently to prevent accidents, personal injury,
and property damage.

WARNING!
Indicates a possibly dangerous situation that can result in death or serious injury if it
is not avoided.

CAUTION!
Indicates a possibly dangerous situation that can result in minor injury if it is not
avoided.

CAUTION!
Indicates a possibly dangerous situation that can result in material damage if it is not
avoided.

NOTES!
Indicates useful tips and recommendations as well as information for efficient and
trouble-free operation.

Do not use a hammer or similar tool when installing the device due to the risk of
damage occurring to the bearings or coupling!

DANGER!

Life-threatening danger due to electric shock!

Indicates a life-threatening situation due to electric shock. If the safety instructions
are not complied with there is danger of serious injury or death. The work that must
be executed should only be performed by a qualified electrician.

A
A

!
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1.4 Disclaimer
All information and instructions in these operating and assembly instructions have been provided un-
der due consideration of applicable guidelines, as well as our many years of experience.
The manufacturer assumes no liability for damages due to:

" Failure to follow the instructions in the operating and assembly instructions

. Non-intended use

] Deployment of untrained personnel

" Opening of the device or conversions of the device
In all other aspects the obligations agreed in the delivery contract as well as the delivery conditions of
the manufacturer apply.

1.5 Copyright

NOTE!

i Content information, text, drawings, graphics, and other representations are protected
by copyright and are subject to commercial property rights.
It is strictly forbidden to make copies of any kind or by any means for any purpose
other than in conjunction with using the device without the prior written agreement of
the manufacturer. Any copyright infringements will be prosecuted.

1.6 Guarantee terms
The guarantee terms are provided in the manufacturer’s terms and conditions.

1.7 Customer service
For technical information personnel is available that can be reached per telephone, fax or email. See
manufacturer’s address on page 2.

2 Safety

DANGER!

This section provides an overview of all the important safety aspects that ensure pro-
tection of personnel, as well as safe and trouble-free device operation.

If these safety instructions are not complied with significant hazard can occur.

2.1 Responsibility of the owner

The device is used in commercial applications. Consequently the owner of the device is subject to the
legal occupational safety obligations, and subject to the safety, accident prevention, and environmen-
tal protection regulations that are applicable for the devices area of implementation.
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2.2  Personnel
Qualified personnel only are permitted to install, mount, program, commission, operate, maintain and
take out of service the devices.

Qualified personnel are people who have received
e training to qualify as an electrician or
e instructions from qualified trades personnel

entitling them to work with and on devices, systems, machinery and plant in accordance with generally
accepted standards and safety engineering guidelines.

In addition, the owner is obliged to deploy only personnel who
o are familiar with the fundamental regulations covering work safety and accident prevention,

e have read and understood the chapter "Safety" in these Operating and Installation
Instructions,

¢ and are familiar with the basic and specialist standards that apply to the specific application.

2.3 Special dangers
Residual risks that have been determined based on a risk analysis are cited below.

Electrical current

DANGER!

Life-threatening danger due to electrical shock!

There is an imminent life-threatening hazard if live parts are touched. Damage to in-
sulation or to specific components can pose a life-threatening hazard.

Therefore:

Immediately switch off the device and have it repaired if there is damage to the insu-
lation of the power supply.

De-energize the electrical equipment and ensure that all components are connected
for all tasks on the electrical equipment.

Keep moisture away from live parts. Moisture can cause short circuits.

Safeguarding against restart

DANGER!

Life-threatening danger if restarted without authorization!

When correcting faults there is danger of the power supply being switched on with-
out authorization.

This poses a life-threatening hazard for persons in the danger zone.

Therefore:

Prior to starting work, switch off the system and safeguard it from being switched on
again.
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3 Technical Data

3.1 Construction

The electronic function module UO-EM-ERC receives the supply voltage and the raw data from the
decoder module. The outputs of the switching contacts (error, relays 1-6) are executed with relays.
The Handshake — output is executed with a solid state relay and the preset - run input with an opto-
coupler.

3.2 Short description

The Universal encoder system U-ONE with the base unit UOM (H) 4 (1) L-1212 and the electronic
function modules UO-EM-D2 (-D41) and UO-EM ERC is a position switch.

Configurable function module is connected to a PC with Windows® operating system (version XP,
Vista, Windows 7 and Windows 8 / 8.1) and the supplied programming software. The physical inter-
face is RS232 (via the decoder).

The 6 switches are switched depending on the set switching points.
The switch outputs are galvanically isolated from the electronics and the PC interface.
The system status is available at the Error output.

3.3 Position switch

The basic unit provides the raw position data. These are offset in the module with the offset values.
These data are used to determine the position. Depending on the programmed switching points, the
output relays are switched.

The device contains for each switching output a safety relay with forcibly guided contacts. Internally,
the current switching state is monitored.

The module contains 6 identical switching channels (R1 to R6). The switch state is indicated by green
LEDs (lit LED = closed switch).

A separate diagnostic switch (Error) includes an error-free diagnosis. This is also indicated by a green
LED on the front of the module. If an error is detected, the switch opens and a red LED lits.

3.4 Preset input

Connection:

The preset input is galvanically isolated and can be connected high or low active.

The handshake output is designed as optorelay. It can be connected as high or low active.

Funktion:

A rising edge at preset input sets the current position to the programmed preset value in the module.
To avoid interference, the input is provided with a debounce time of 100ms.

The handshake output indicates the function " Preset setting" by means of a closed relay. The dura-
tion of the signal depends on the duration of the signal at the preset input. Pulse stretching is used to
simplify signal evaluation. The minimum pulse length is 100 ms. The handshake output is also acti-
vated when the preset value is set using the operating software (ERCPro).
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3.5 Type plate /connection diagram
I ® —-..-IOHANNES— T@I@I@ i (0] [©)
UONE HUBNER 0)(6] 0] (6] K 0] 6] [6)

NC | COM | NO

Typ - UO-EM-ERC E;E?R 234 221 -

Type l’t REL 2 7 6 38
- REL 3 11 10 12

REL 4 15 14 16

ID - 19596 % REL 5 19 | 18 | 20

REL 6 27 26 28
S/N 1 23456 Bj/Y 2014 handshake 31 32
Johannes Hubner c € preset input 30 29

Fabrik elektrischer Maschinen GmbH
Siemensstrasse 7 - 35394 Giessen - Germany

[ [©) ()] (@] K (€] (€] [©)
6] 2 B [¢)] K (0] 6] [0)

3.6 Connected loads environment

Description Value

Supply voltage Supply via bus connections (12 ... 30 V DC)
Power consumption max. 6 W

Connection COMBICON®-terminal strips

Relays with forcibly guided contacts
Switching outputs R1 — R6 max. 250V AC/DC, 500mA

Relay contact

Switching output Error max. 250V AC/DC, 500mA

Preset input potential free voltage 12 ... 30 V DC / approx. 5 mA
Programming interface RS 232

Connecting diagram EL 777

Device temperature range -25...+70°C

Degree of protection 1P20




HUBNER

ideas and solutions

3.7 Connectors and Indicators

QL O

Universal encoder system U-ONE®

Electronic functi

on module UO-EM-ERC

S/N:123456

PWR STATE

RELAIS

1

®

®
4

UO-EM-ERC

QOLQD 900

3.8 Mounting the module

3

o

o
6

Indicators

R1

LEDs light up when
-R6 .
switches are closed

State

Green LED Lit: Operational
Red LED lit:  Error condition

PWR Red LED lit:  Module is operational

Snap the modules onto the top-hat rail and slide together.

ATTENTION!

Ensure you do not damage the connectors when you snap the modules onto the rail
) and push them together!

The module must be mounted in a voltage-free state!

Ensure the modules contact reliably when joining them together on the top-hat mounting rail.
Fit the supplied shrouding covers to both ends of the mounted terminals.

Follow the connection diagram!

3.9 Dimension drawing

99

Hd .

—V////,Zm—

A=11450 mm
B =45 mm
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4 Installation and Configuration

4.1 Installing the software
Place the CD into the CD drive or, alternatively run the file: index.html.

Imprint Terms and conditions Contact

U-One® Software
Please install the U-One® Version 2.x Rev. 4.0

Software at last Description

more... &
Gear | Menu software for U-One® Moduls

Operating | Microsoft Windows 9x, NT, 2000, XP, Vista (as
system [Admin) and Windows 7

Connection | One free COM- Port connection

Computer | At least 20 MB free fixed-disk storage

Following gear can you choose for
software installation
| AWG  (Pro-Software)
| EGS® 4 (Pro-Software)
| ERC 3 (Pro-Software)
|UrOne5 (Pro-Software)

At least 800 x 600 screen resolution

Software installation
joriver Profitiss U-One® Software installation &/

| Driver CANOpen
| Driver DeviceNET

Johannes Hiibner - Fabrik elektrischer Maschinen GmbH
Siemensstrasse 7 - D-35394 Giessen/Germany « Tel. +43 641/79 69-0 - Fax +49 641/7 36 45

www.huebner-giessen.com - info@hu

— | E S S E N —

Select "U-One® (Pro-Software)" in the left column then click the "Install ->" button.
When the dialog box "Internet Explorer - Security Warning" is displayed

' User Account Control ﬂ

J Do you want to allow the following program from an
*/" unknown publisher to make changes to this computer?

Program name:  setup.exe
Publisher: Unknown
File origin: Hard drive on this computer

) Show details Yes No |

Change when these notifications appear

Click the "Run" button. The installation software will now launch.

HUEBNER-GIESSEN U-One Setup

3 HUEBNER-GIESSEN U-One Setup. q

g Welcome to the HUEBNER-GIESSEN U-One installation program.
=

Setup cannot install system fles or update shared fies if they are in use.
Before proceeding, we recommend that you dose any applications you may
be running.

Exit Setup

Click the "OK" button in the dialog box "HUEBNER-GIESSEN U-One Setup.
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J HUEBNER-GIESSEN U-One Setup 3 x|
Begin the installation by dlicking the button below.

i
¢ Click this button to install HUEBNER-GIESSEN U-One software to the specified
destination directory.

—Directory:
C:\Program Files (x86)\UOne\

Change Directory | ‘
Exit Setup |

Then click the Install software button in the dialog box "HUEBNER-GIESSEN U-One Setup.

+/% HUEBNER-GIESSEN U-One - Choose Program Gro x|

Setup will add items to the group shown in the Program Group box.
You can enter a new group name or select one from the Existing

Groups list.

Program Group:

I UEBNER-GIESSEN

Existing Groups:

Accessories
Administrative Tools
Autostart
BefundPro

Maintenance

Microsoft Web Publishing
Notepad++

PCAN USB

Dro%ox

pi|

Continue I Cancel

Then click the "Continue" button in the dialog box "THUEBNER-GIESSEN U-One - Choose Program

Group.

HUEBNER-GIESSEN U-One Setup

HUEBNER-GIESSEN U-One Setup was completed successfully.

X|

Die Installation der Software U-One mit ,OK“ abschlief3en.

Analog zu dieser Installation die ande

Module
UO-EM-EGS4
UO-EM-ERC
UO-EM-AMS

ren bendtigten Programme installieren.

Programm

EGS4 (Pro-Software)
ERC3 (Pro-Software)
AWG (Pro-Software)
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4.2 Configuration of the software

Launch the configuration program (UONE) as administrator.

e — — E
= T — T —
2 V — O HAN N E S S—
- -
UVBNER
——— CESSEN —
Fabrik elektrischer Maschinen GmbH
(s ] .
Camm-Port | | G I
in - Unit
Qo (E— H ' @ Scann
[Eee] TestPort 9 NOP Test
Settings
Close

When an UO-EM-D2 (or D41) module is connected and switched on, click the "Scan" button; if that is
not the case, select "Serial interface" from the "Settings" menu.

Click the "Save" button.

Configuration is now complete.

4.3 Operating the software
Launch the configuration program (UONE)
The UONE overview screen opens to provide a graphic overview of the connected modules.

X

JOHANNE'S se—

— CIESSE N E—
Fabrik elektrischer Maschinen GmbH

Version 2.% Rev 4.0

Now click the "Start" button in the ERC - Unit graphic icon to launch the program ERCPro3.
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P crcrros cvone,

File View Options Help

— ) QHANNE S e—
HUBNER

— S E N E—

*Company: [

Contact person: [

Telephone number |

eMail: [

T T

i .
R2 Chasne%%'ll;asic
m Read
I . Programming
o —] e

Complete the fields in the Licence information dialog box, then click the "Save" button.
The Licence information dialog box will then close.

% ERCPro3 <UOne>
File View Options Help

x|

please start ABS-Read

g
3
2
8

Switching position _mm

I
I
I
I
i

[T T AT T

fH

Data must be read-out of the module. To do so, click the "Read" button. Data from the module popu-
late the fields.
A flashing yellow dot signalizes that position data is being read out of the module.
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4.4 Change default settings
Edl <Uone i

(100 Jeom cumentpos.
l““l] Switching position

=
(6] 100 [ to0 |

Range [0 Jem Measure

It is possible to change the basic ERC unit settings (dark-grey shaded area).
To do so, click the "Change basic settings" button.

Ix

@™ ERCPro3 <UOne>

File Visw Options Help

MATTENTION Il Change basic
settings has consequence on max. switch
points. Count direction change has
consequence on absolut value

_Lx Rev 9.0
ERCSV 7.3

ey 100 | 1000 ]
| on o0 ]

[R5 o0 | o |
[on 0

s 100 | 1000 ]
| on o0 ]

900

S 100 | 1000 ] S
| on [0 ]

500

(] o [ o |
[on o ]

1. SIN
This field displays the serial number of the module; this information is read only and cannot be
changed.

2. ERCPro Ver.
This field displays the version of the programming software; this information is read only and can-
not be changed.

3. ERC Firmware
This field displays the firmware version of the UO-EM-ERC — module; this information is read only
and cannot be changed.

4. Negative value
When the Negative value box is selected, the displayed value range is placed in the middle of the
value range of the basic unit. The display can now display positive and negative numbers.
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5. Error handling
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Click the "Edit" button. The "Error handling" dialog box opens, in which the type of error handling
procedure is determined for internally recognized errors and warnings.

HWATTENTION ! Change basic
settings has consequence on max. switch
points. Count direction change has
consequence on absolut value

[339888
[5:x Rev 9.0
Error handling 7 LR
|
relay error hold &  self reset min. 4s
|_edit_|

Preset setting [0 |

step error hold &  self reset min. 1.2s

relay driver ermor hold & " self reset min. 8s

Cancel

(2] 10 | 1o |
I

[F] o0 1 oo |

Pro

gramming

It is possible to program each error so that the ERC module stores the error until the supply voltage
is switched off (hold) or is applied for a fixed time period (pulse).

When in the operating mode "Pulse" the module resets the error automatically after a fixed time pe-
riod elapses.

In that event the higher-level controls are responsible for storing the error information.

Once you have selected the desired option, click the "Apply" button.

. Preset setting

The preset value for the module is entered in this field. This value is transmitted immediately to the
UO-EM-ERC module when you click the "Preset setting" button.

The position value is always set to this value when the hardware input "Preset setting" is activated.

. Hysteresis

The switching hysteresis is entered in this field (switch-on and reset hysteresis of the relays). The
value is entered in encoder increments (1-255). This determines the difference between the switch-
on and switch-off points of a switching point.

. Count direction
The selected option determines if the position value increases when the encoder shatft is turning in
a clockwise or anti-clockwise direction.

. Factor

It is possible to enter a conversion factor in this field. Raw encoder data are multiplied by this factor
and displayed.

Caution!!!

Any changes to this setting will influence the switching points. You will need to check and possibly
adapt the corresponding settings (see chap. 4.5).

10.Unit

It is possible to select a character string from the Unit drop-down list, which is displayed as the unit
of the displayed values. It is also possible to define the character string in the system settings.
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11.1dentification
The character string entered in this field serves to identify the module. The user is able to choose
the characters in the string up to a maximum of eight characters.

12.Last edit
The date data was last transmitted to the module is displayed in this field.

To write the data to the module click the button "Programming". By contrast, if you do not wish to save
the edited data click the "Close basic setting" button.
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4.5 Change switching points
=

File View Options Help

g [T

T

[0 Jem

It is possible to adjust the range of the graphic display by entering positions in both "Range" fields.

The ERC module offers 6 independent channels, each of which has a relay as output stage. 2 switch-
ing points can be assigned to each channel. The programmed switching range may also exceed the
zero reference point.

The switch-on points are entered in the left field, and the switch-off point points in the right field. When
entering the switching points please note that they are scaled according to the set "factor”. The value
range of the encoder (factor = 1) is 0 to 2*-1 (16777215).

Several options are available to the user to complete the fields:
- Enter value manually.

- Click the value in the field "Current pos." and copy the value to the target field by holding down
the left mouse button in a drag-and-drop operation

- Hold down the left mouse button to move the yellow bar. The lower limiting arrow moves the
entire bar, the upper limiting arrow changes the length of the bar.

It is possible to invert the switching function of the channel by double-clicking "ON" or "OFF".

Click the "Programming" button to write and save the new values to the ERC module.




HUBNER Universal encoder system U-ONE®

ideas and solutions

Electronic function module UO-EM-ERC

4.6 Measure function

The "Measure" function is an aid that makes it possible to determine the scaling factor. It can be used
when the scaling factor of the system is unknown. It is essential when using the program that the
speed ratio between the mounted position of the encoder and the axis to be configured is constant
and there is a linear relation between the axis position and the data word of the encoder.

To start the function, click the "Measure" button.

LEmEXITESE X

1. Set machine to 1. Position and enter measured valu in
1. Position’

Setting Pos.1

1. Position 1. Abs-value

2. Set machine to 2. Position and enter measured value in 2.
Position"

2. Position 2. Abs-value

3. Distance and Factor will be calculated

Distance Unit Factor

|| SO —

(13 I c-:d]

Caution! The absolute value of position 1 must be less than the absolute value of position 2; more-
over, zero crossing is not allowed between these two positions.
The accuracy of the calculation is greater when both positions on the axis are as far apart as possible.

Move the axis to the first position. The current raw encoder data are displayed in the field "1. Abs-
value". Now enter the desired value in the field "1. Position". To apply the data, click the "Setting Pos.
1" button.

Now move the axis to the second position. The current raw encoder data are displayed in the field "2.
Abs-value". Now enter the desired value in the field "2. Position". To apply the data, click the "Setting
Pos. 2" button. The factor will now be calculated and displayed in the field "Factor".

Click the "OK" button to store the value in the buffer memory. Click the "Cancel" button to abort the
procedure and close the dialog box.

The message "Factor = xxxxx" is now displayed in the message area of the UONE overview screen. If
you wish to use this value, you must enter it in the field "Factor" (see Change basic settings).
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4.7 Pulldown-Menu ,,file*
In the File menu it is possible to save, load and print out data as well as change program settings.

I| File View Options Help
Load..
Save as..

Print

Settings
Exit ->UOne

1100

1. Read parameters
"File->Load.." opens the "Open *.DAT file" dialog box. Select and load the parameter file (*.DAT)
into the programming software.
To be able to transmit the data to the module, you must click the "Programming” button.
Caution! The preset value is not transmitted and must be set separately.

2. Save parameters
"File->Save as.." opens the Save as dialog box. To save the parameters (settings) select a destina-
tion folder and specify a file name for the parameter file (*.DAT).

3. Print
File = Print" prints the parameter on the standard printer.

4. Exit
"File = Exit ->U-One" terminates the program and launches the configuration program (UONE).

4.8 Pulldown-Menu ,file 2 settings*

rf?ile— View Options Help
Load..
Save as..

Print

T Simulation
Exit ->UOne
Language »

System
Programsettings

1. Communication port
"File > Settings > ComPort" opens the Comm-Port Settings dialog box.

*ia Comm-Port Settings x|
Comm-Port | | -
& ‘ Scann
TestPort 9 NOP Test
Settings
Close

Under normal circumstances users are not required to use this menu item, because the settings in
the configuration program (UONE) have already been set. If it is not possible to establish a com-
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munications with the module, carry out the settings as described in chapter 4.2 Configuration of the
software).

2. Simulation
"File > Settings = Simulation" sets the software to "showroom" mode to be used for demonstra-
tion purposes only.

3. Select language
"File > Settings »>Language" enables the user to set the desired user interface languag.

Selection User interface
Deutsch Deutsch

English English

User Is not longer supported

4. Factory settings
"File = Settings > System" launches a menu to request a code.
It is only possible to request a code over the phone.

|
Please give this CODE to Hiibner by phone oK
and put our reply into text field ——-l
Cancel

Phone no. : +49 641 / 7969 43
Detail Info
ERCPro version : 3.x Rev 9.0
Firmware : ERCSV 7.3
Licence for : sdfsdf
Current Serial No.: 999888
CPU-Time : 0.000

Code : 2512609F17

Reply : |
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5. Program settings
"File > Settings > Programsettings" opens the Programsettings dialog box.

I” read after save

I Frimware scann first ERC than ERCS

~ View
I~ Show mesages I~ no splashscreen
Benutzerdefinierte Einheit

i~ Logfile sa
I Logfile save
IE' read retry

Commandine | 7
Save Cancel

User selectable settings are listed in the table below.

Description Function

read after save After the switching points are pro-
grammed the "read" command is exe-
cuted (corresponds to clicking the
"Read" button).
This function is always activated no mat-
ter what selection is made.

Firmware scan first ERC then ERCS | This setting is required for other devices
and is of no relevance in this instance.

Show messages Activates additional messages.

no splashscreen Program information is not displayed
when the program is launched.

User defined unit Text field for user defined unit.
This is determined when making basic
settings.
The characters are saved locally on the
PC.

Logfile save Save data communication with the mod-
ule to a file.

read retry It is possible to enter a value in this field
in the event communication problems
arise (< 10).
Communications are slowed if the value
is too high.

Commandline This is reserved for future programming
options, it remains unused.
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4.9 Pulldown-Menu ,,View*
Settings for the graphic user interface are made in this menu.

I File | view Options He

v Actual value
Reverse indication
Graphic 2

v differense
Coloring >
Format
Log-File

1. Position display
"View - Actual value" switches the position display bar on or off in the switch graphic over-
view.

2. Zero reference point of position display
"View > Reverse indication" reverses the fields displaying the range view (top <-> bottom).

3. Position display
"View - Graphic 2" opens the GRAPHIC 2 overview with a different representation of the ac-
tual position.

4. Difference display
"View -> Difference" switches the display showing the difference between the switching points
(relay on range) on and off.

5. Coloring
"View - Coloring" allows the user to define the color representation of the graphic interface.
You must close and relaunch the software for the changes to take effect.

6. Format option
"View 2> Format" enables the user to select the display resolution. It is possible to make this
setting independent of the position display and the switching points.
To confirm this setting click the "Read" button.

7. Display log file
"View - Log-File" opens the log file in an editor.

4.10 Pulldown menu "Options™
"Options > Visual setting" switches the option on and off that enables the user to set the switching
points by moving the bars.

4.11 Pulldown menu "Help"
"Help = Info ERCPro3" displays the program information dialog box.
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4.12 Proper use
The electronic function module UO-EM-ERC of the universal encoder system U-ONE serves as
a position switch; it is designed and built to operate exclusively with the basic unit UOM(H)
4(1)L-1212 and the electronic function module UO-EM-D2 (-D41) for the sole purpose described
in this manual.

We do not accept liability of any kind for damages arising from improper use of the device. The
owner bears sole responsibility for any improper use.

4.13 Improper use
¢ Do not use the device in potentially explosive areas.
¢ Itis not permitted to use the device in locations higher than 3000 m above sea level.
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4.14 Faults table
Faults

Diagnostic switch
does not close

Universal encoder system U-ONE®

Electronic function module UO-EM-ERC

Possible cause Remedy

No supply voltage Check connection cable and supply voltage
Check basic unit:

Green LED in terminal box
does not lit.

Check electronic modules:

No LEDs lit

An fault was detected. Check supply voltage on the basic unit
Red LED on the ERC module Check fibre optic cable

lit.

,Ready“— LED on the decoder

does not lit

An fault was detected. Read out fault memory with programming
Red LED on the ERC module software

lit.

,Ready“— LED on the decoder

lit

Contact Hubner-Service (page 2) if none of the actions listed above provides a solution!
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4.15 Error table

Error report

0) Internal ERROR (EEprom
to RAM)

1) Relais ERROR

3) Base unit error

4) Step error !

5) Base unit error D2

7) CRC ERROR

Universal encoder system U-ONE®

Electronic function module UO-EM-ERC

Description

The checksum for a data record in the
EEPROM is invalid

Possible cause:
The supply voltage was too low during an
EEPROM write operation

The setpoint and actual switching status of a |

relay do not match

Possible cause:

The supply voltage was too low during a
switching operation

The ambient temperature is too high
Resistance across relay contact too high

Die received position data is invalid

Possible cause:

A fibre-optics cable is faulty

The power supply to the basic unit is outside
of the allowable range

The basic unit is faulty

Received position data is inconsistent

Possible cause:

A fibre-optics cable is faulty

The power supply to the basic unit is outside
of the allowable range

The basic unit is faulty

Error in multiturn encoder

The D2 (D41) — decoder has detected a
communication error

Possible cause:

A fibre-optics cable is faulty

The power supply to the basic unit is outside
of the allowable range

The basic unit is faulty

Error ratio of data transmission checksum
too high

Possible cause:
A fibre-optics cable is faulty

Remedy

Preset setting (see chap.4.4)

Check and enter switching
points (see chap.4.5)

Check and enter basic set-
tings (see chap.4.4)

Switch voltage supply off and
back on again

Ensure ambient temperature
is within range (see chap.3.6)

Always switch off unused
switching channels (see
chap.4.5)

Test fibre-optics cable

Check the power supply to the
basic unit

Replace the basic unit

Test fibre-optics cable

Check the power supply to the
basic unit

Replace the basic unit

Test fibre-optics cable

Check the power supply to the
basic unit

Replace the basic unit

Test fibre-optics cable

Contact Hubner-Service (page 2) if none of the actions listed above provide a solution!
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5 Transport, packaging and storage

5.1 Safety information concerning transport

CAUTION!

Material damage caused by improper transport!
Observe the symbols and information on the packaging:

= Do not throw - risk of breakage

= Keepdry

= Do not expose to heat above 40 °C or direct sunlight.

© —)

5.2 Goods inward inspection

Check the delivery immediately upon receipt for transit damage or short delivery.

Inform the carrier immediately on receipt if you determine that damage has occurred during transit
(take photos as proof).

5.3 Packaging (disposal)
The packaging is not taken back; dispose of according to the respective valid statutory provisions and
local regulations.

5.4  Storing packages (devices)

‘
‘

. Keep dry
4 Ill. *  Keep packages dry and free from dust; protect from moisture.

‘

o
//I "~ Protect against heat
P

Protect packages from heat above 40 °C and direct sunlight.
If you intend to store the device for a longer period of time (> 6 months) we recommend you use
protective packaging (with desiccant).

O NOTES!
Turn the shaft of the device every 6 month to prevent the bearing grease solidifying!
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5.5 Returning devices (repairs/goodwill/warranty)
Devices that have come into contact with radioactive radiation or radioactive materials are not taken
back.

Decontaminate devices that have may come into contact with harmful chemical or biological
substances before returning.

They must also be accompanied by a safety clearance certificate.

5.6 Disposal
The manufacturer is not obliged to take back the device.

The device is classed as electronic equipment and subject to the WEEE Directive; observe local,
country-specific laws when disposing of the device.

For information on environmentally sound disposal please contact your local authority or a specialist
disposal company.
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6 EU-Declaration of Conformity

S UOHANNES e EU-Konformitatserklarung

HUBNE (EU-Richtlinie 2014/30/EU)

- EU-Declaration of Conformity
(EU-Directive 2014/30/EU)

Hersteller / Manufacturer: Johannes Hibner Fabrik elektrischer Maschinen GmbH
Anschrift / Address: 35394 Giessen, Siemensstrasse 7
Produktbezeichnung / Product designation:

Elektronik-Funktionsmodul UO-EM-ERC
Electronic function module UO-EM-ERC

Die bezeichneten Produkte stimmen in der von uns in Verkehr gebrachten Ausfiihrung mit
den Vorschriften folgender Européischer Richtlinien iiberein:

The products described above in the form as placed on the market are in conformity with the
provisions of the following European Directive:

2014/30/EU (Ausgabe / Version 2014-02-26)

Richtlinie des Européischen Parlaments und des Rates vom 26. Februar 2014 zur Harmonisierung
der Rechtsvorschriften der Mitgliedstaaten tber die elektromagnetische Vertraglichkeit

Directive 2014/30/EU of the European Parliament and of the Council of 26 February 2014 on the
harmonisation of the laws of the Member States relating to electromagnetic compatibility

DIN EN 55011 (Ausgabe / Version 2011-04) Industrielle, wissenschaftliche und medizinische
Gerate - Funkstérungen - Grenzwerte und Messverfahren

Industrial, scientific and medical equipment - Radio-frequency disturbance characteristics -
Limits and methods of measurement

DIN EN 61326-1 (Ausgabe / Version 2013-07)

Elektrische Mess-, Steuer-, Regel- und Laborgerate - EMV-Anforderungen - Teil 1: Allgemeine
Anforderungen

Electrical equipment for measurement, control and laboratory use - EMC requirements --
Part 1: General requirements

; Frank Tscherney :
UnterschnftW/Hy/ (Geschftsfiihrer / General manager) Gieften, 17.01.2017
Y




